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Welcome to PCLinuxOS magazine. We've included plenty of good stuff for
you to enjoy. You've probably all met RaveDave on the main forum; he was a
Linuxer before there was Linux. There's a bit of wry humor from Britbrian,
and a how-to on setting up Lords of Destruction to run under Wine. For those
worried that the current 0.92 and 0.93 repositories may "go away" after 0.94
is released, there is a great tutorial on creating your own local copy of the
repositories. There is lots more.

Now for some news. Next month, we will have a treasure hunt for our
readers. The prize will be announced in next month's issue in my editorial.
This month, though, | thought we'd give you a preview. As you read the
articles, notice that some graphics have a small yellow dot on them, with a
red letter, number or punctuation mark inside the dot. These characters
make up a "key" to unlock the treasure chest. Write them down and then
organize them to make a word, words or phrase. Pay attention to
capitalization; it's important. When next month's issue "hits the street" you'll
need to be the very first one to correctly assemble the key and visit a special
link I will publish in my editorial. If you are first, you win... well, I'll tell you
what you win next month.

Why are we doing this? We're hoping while you are there entering your guess
at the treasure key that you'll take the time to fill out our demographics
survey. No personal information is collected there (except for the winner, who
must provide us a contact email address). The data collected will help us
here at PCLinuxOS Magazine do a better job providing you with what you
want.

So check out this month's graphics and see if you can guess the preview key.
I'll announce what it was on the main forum in the Magazine's section.

Tim Robinson
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Announcement:
PCLinux0S 0.93a
Released

Texstar announced on August 21, 2006 the availability for
download or online ordering of PCLinuxOS 0.93a Full Edition
aka Big Daddy.

The full edition comes with Kernel 2.6.16.27, KDE 3.5.3, Open
Office, Firefox, Thunderbird and Nvu. Digikam, Gimp and Gqgview
for your digital photo needs. Amarok, Audacity and Audio Creator
for your digital music needs. Frostwire, bittorrent and gftp for file
transfers and p2p file sharing. Mplayer and Kaffeine for video
viewing. (libdvdcss2 required for dvd encrypted playback). Kopete
and Xchat for online chatting. Blogging and podcast software also
included. PCLinuxOS Big Daddy is the full monty!

PCLinux0S 0.93a Big Daddy

PCLinuxOS 0.93a - Full Edition aka Big Daddy is now available.
This is our full version of the PCLinuxOS Distribution.

Internet Suite

Internet, Email, instant messaging, and more! PCLinuxOS
includes The Mozilla Firefox Web Browser and Thunderbird Email
Client. Kopete Instant Messenger allows your to chat with friends
on Yahoo, MSN and AIM.

Complete Open Office Suite
PCLinuxOS comes with a complete Open Office suite for word
processing, spreadsheets, drawings and slide presentations.

Digital Photos

Digikam is a pre-installed photo managment program that allows
you to download, organize, edit, and share your entire photo
collection. Easily connect your digital camera to your computer
and import all of your pictures with a few mouse-clicks. In addition
to Digikam, PCLinuxOS also includes the powerful GIMP image
editor.

Digital Music

Manage your favorite tunes with Amarok, an all-in-one music
player built into PCLinuxOS. Burn and rip your favorite music with
Audio Creator. Fileshare through Frostwire.

Web Publishing Tools

PCLinuxOS includes Nvu, a powerful, easy-to-use web design
program that is open-source. Anyone can create web pages now,
even those with no technical expertise or knowledge of HTML.

PCLinuxOS allows you to try it in Live mode without touching your
current system. If you like PCLinuxOS you can easily install it to
your computer using the easy to use Installation program. After
installing PCLinuxOS to your computer, you can access an
additional 5000 programs and libraries from our free software
repository.

If you are tired of Windows constantly crashing all the time, the
blue screens of death, the nasty viruses/trojans, constant pop-
ups, and sluggish performance then PCLinuxOS is for you.

Switch to PCLinuxOS today!!!

The current list of programs on the Full Edition of PCLinuxOS
0.93a can be found at http://www.pclinuxos.com//page.php?13l.


http://www.pclinuxos.com//page.php?13l
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Packet Writing in

PCLinux0S

by Clareoldie

acket writing has been available in Windows
operating systems for a long time through the
use of third party software. My experience
ith this was problematic, as over the years the
formats changed a little and there was no backward
compatibility. I guess that is what happens with
proprietary formats.

Packet writing can be implemented in PCLinuxOS and
is not at all difficult to achieve. There is as yet no
'overall' application which would hide the workings
from a user. Maybe soon that will change. Meanwhile
the same result can easily be achieved by doing the
steps separately yourself. This document will help you
do this. The procedure is laid out in three main
categories:

A. Operating System setup
B. Hardware setup
C. Media setup

Operating System

To begin, you must install udftools from the
repository. Next you need to make sure that the
required modules are loaded at startup. These are not
yet built into the kernel, so the file
/etc/modprobe.preload needs to be edited. Go to
Kmenu->Applications->FileTools->FileManager
Super User Mode and launch it. Navigate to the /etc
directory and, using right click with the mouse, select
to open the file modprobe.preload with an editor like
Kwrite. Add udf and pktedvd, each on its own
separate line, to the file, and ensure there is an empty



line at the end of the file (the order is not important).
Don't change anything else in the file while you are
editing it. Your file might look something like this:

# -~ modprobe.preload - KWrite

Eile Edit Wiew Bookmarks Tools 3Settings Help

f'g Lj LJ - E:i
yealink
|uskhid
|pktcdud
|udf
| w_ random

.-\.

|__\_'|' | &
P R

Save the file to ensure the changes you have made are
permanent. Reboot the computer to ensure the
modules are loaded. PCLinux Operating System is
now set up to use Packet Writing.

The next stage is to set up the hardware.

Hardware Setup

You will need a DVD drive capable of burning RW
media. My burner, a Pioneer 107D, uses +RW media,
so I have not checked this out on -RW media. You will
also need a DVD RW media of 4.7 GB capacity.

First, the optical drive needs to be set up for packet
writing so the fstab file needs to be edited. As

previously described, using File Manager Super
User Mode, navigate to the /etc directory and open
fstab for editing with Kwrite. Add this line to the fstab
file:

/dev/pktcdvd/0 /media/packetcd0 udf
noauto,noatime,rw,users 0 0

(If you are viewing the online version of the
PCLinuxOS Magazine, you can copy and paste the
above into the file to prevent typing errors.)

Save the fstab file. It might then look something like
this (see line 12):
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Note: Your /mnt/cdrom line should be something like
line 13. If you have problems with fstab entries help is
available on the forum. Here is another example of an
entry for an optical drive:



/dev/hdd /mnt/cdrom auto
pamconsole,exec,noauto,utf8,codepage=8
50,iocharset=is08859-1 0 0

Warning

It 1s vital that you select the correct optical drive for
burning and take note of its details, e.g., /dev/hda
/mnt/cdrom above (line 13). If you have more than
one optical device make sure you select the correct
one. You will need to know the location of your device
for later.

Next you need to use a terminal, so open it and get
root permissions by typing su <enter> and then type in
the root password. The password will not appear on
the screen for security reasons so just press <enter>
after you have typed it in. You should now have
something similar to this in the terminal:

[myname@Pentium ~]$ su
Password:
[ root@Pentium myname]#

The '#' sign indicates that you have root permissions.
Next type in (or copy and paste):

pktsetup 0 /dev/hd? <enter> Please make sure that
you change the hd? to the correct location for your

burner which you took note of earlier. Your hardware
should now be set up for Packet Writing. That brings
us to the third stage of the process.

Media Setup

Place a DVD+RW 4.7GB media in the burner and
format it using K3b or whatever burner you normally
use. Leave the media in the drive. Open a terminal and
get root permissions as above, or use the existing
terminal if you haven't closed it. Type or copy & paste
the following line into the terminal and press enter:

mkudffs /dev/hd?

Again, change the entry to suit the location of your
burner (hda, hdb, hdc, etc.). This makes the media

capable of packet writing. You can expect to see an
output something like this:

[root@localhost ~]1# mkudffs /dev/hda
start=0, blocks=16, type=RESERVED
start=16, blocks=3, type=VRS

start=19, blocks=237, type=USPACE
start=256, blocks=1, type=ANCHOR
start=257, blocks=16, type=PVDS
start=273, blocks=1, type=LVID
start=274, blocks=2294573, type=PSPACE
start=2294847, blocks=1, type=ANCHOR



start=2294848, blocks=239, type=USPACE
start=2295087, blocks=16, type=RVDS
start=2295103, blocks=1, type=ANCHOR
<pause>

[root@localhost ~]#

Note: There can be a quite delay at the <pause> above.
Give it time to finish.

Eject the media and re-insert it again. If you have your
desktop set to display icons then an icon should appear
with a name like LinuxUDF. At this point the only
thing on the disk will be the directory Lost and
Found.

One thing remains to be done. As the media was
formatted by root it has permissions which only allow
root to write to it. You must now change this. This is a
one time operation as the permissions are written to
the disk. There are many ways of changing
permissions on the media. (If you are comfortable
with the command line then it can be done there
using the chown command.) For a new user it is
probably easier to briefly log in as root user and right
click on the icon, go to properties, and select the

permissions tab. You will be presented with a screen
like this:

Change the permissions to allow Group and Others

=l

}

. Propertiesifor hdd - XDesktop " 95 SRR
General | PErmissions

Access PErmissions

Owner: él;an View & Modify Content i
Groyp: [Can view & Modify Conbent d
Others: | Can View & Modify Content -

] Only owngr can r & and delete folder content

Advanced Permissions

Ownership

user: root
Group: rook

¥ Apply changes to all subfolders and their contents

OK Cancel

to read and write to the media. Also tick the box to
'Apply changes to all subfolders and their contents.'
Click 'OK' to save the changes. Log out of root
immediately and go back to your user account.

That is it. You now have a DVD that you can treat like
a floppy except much larger and faster. If, when
deleting files from the disk, you send them to the
Waste Bin then it may be necessary to empty the
Waste Bin before you can eject the disk. As with all



removable media it is good practise to 'unmount' and
'eject’' the media by right clicking on the desktop icon
and selecting the preferred option. This ensures that
all write actions have been finalised before the media
is ejected. To do otherwise could result in
corrupted/incomplete data on the media.

Please note that I found a size limitation of 1GB for
any file. I could easily copy large ISO files to the disk

but when I tried an ISO greater than 1GB (1.2GB) it
only wrote the first IGB and then popped up an error.

Happy saving!

Night Before Christmas

"Twas the night before Christmas and Santa's a wreck...
How to live in a world that's politically correct?

His workers no longer would answer to "Elves”,
"Vertically Challenged" they were calling themselves.

And labor conditions at the North Pole

Were alleged by the union to stifle the soul,

Four reindeer had vanished, without much propriety,
Released to the wilds by the Humane Society.

And equal employment had made it quite clear

That Santa had better not use just reindeer.

So Dancer and Donner, Comet and Cupid,

Were replaced with 4 pigs, and you know that looked stupid!

The runners had been removed from his sleigh;
The ruts were termed dangerous by the EPA

And people had started to call for the cops
When they heard sled noises on their roof tops.

Second-hand smoke from his pipe had his workers quite frightened.
His fur trimmed red suit was called for the tooth.
Nothing that seemed to embellish a truth.

And fairy tales, while not yet forbidden,

Were like Ken and Barbie, better off hidden.

For they raised the hackles of those psychological
Who claimed the only good gift was one ecological.

No baseball, no football....someone could get hurt;
Besides, playing sports exposed kids to dirt.

Dolls were said to be sexist, and should be passe;
And Nintendo would rot your entire brains away.

So Santa just stood there, disheveled, perplexed;
He could not figure out what to do next.

He tried to be merry, tried to be gay,

But you've got to be careful with that word today.

His sack was quite empty, limp to the ground;
Nothing fully acceptable was to be found.
Something special was needed, a gift that he might
Give to all without angering the left or the right.

A gift that would satisfy, with no indecision,
Each group of people, every religion;
Every ethnicity, every hue,

Everyone, everywhere...even you.

So here is that gift, it's price beyond worth ...
"May you and your loved ones enjoy Peace on Earth."

(c) Harvey Ehrlich, 1992.

NOTICE: This poem is copyright 1992 by Harvey Ehrlich. It is free to
distribute, without changes, as long as this notice remains intact. All
follow-ups, requests, comments, questions, distribution rights, etc.
should be made to mduhan@husc.harvard.edu. Happy Holidays!!



How To Create An

Update CD or DVD

by cogDis

he purpose of this document is to
( Z demonstrate the steps involved in creating a
custom built CD that contains the necessary
packages to perform a system wide update of a .92 or
.93 PCLOS installation. The main intent is to provide

those users who have limited or no Internet
connectivity, a means to keep their systems up to date.

Requirements:

1. A listing of the installed packages from the
computer to be upgraded. This is a text file that we
will create in step one, copied to a floppy, CDROM, or
other removable device, that can be transported to the
host machine used to create the Update CD.

2. A host computer with an Internet connection (the

faster, the better) capable of booting and running a
PCLOS .92, or .93 Live CD.

3. The computer used to create the Update CD must
have some type of writable storage, of sufficient size,
to temporarily store the downloaded package updates.
Currently, this is approximately S60MB for a complete
update of a basic .92 install or 600MB for a standard
.93 install. Your mileage may vary, dependent upon
the requirements of the system you intend to update.
This storage can be a writable partition on the host
computer, or some type of external storage device,

such as a USB hard drive, or flash drive.

4. If the host computer has a spare CDRW drive that
isn't being occupied by the Live CD, the entire
operation, including the burning of the actual Update



CD, can be done from within the Live CD session.
However, as the Live CD cannot be removed during
the session, the lack of a spare burner will require that
the created archive be moved to another PC for
burning, or moved to a partition on the host computer
that is accessible by another OS capable of burning
the desired disc.

The steps:

I'll describe the steps involved, in order, with the
commands used, supplemented with actual examples
from my own system, where possible.

1. Create the package listing on the computer being
updated. The first step is to create a list of packages
present on the system you wish to update. This
package list will be taken to the host computer, where
it will be loaded into Synaptic. In a terminal, execute
the following command:

rpm -ga ?gf '${NAME}\n'|sed -e
/kernel*/d -e /gpg*/d -e 's/$/
install/'| sort >installed.txt

This will create a file in your home folder called
installed.txt. If you need to perform these next steps on
another computer, you will need to copy this file to
some type of removable media, and take it with you to

step 2.

2. Boot the host system with the PCLOS .92, or.93
Live CD.

3. Mount the writable storage device that will be used
to temporarily store the downloaded packages. This
can be done with Konqueror by selecting Go > Storage
Media, and selecting the partition or device, or with
the mount command. In my case, I have a spare
partition, /dev/sda3, that I will mount manually. In a
root terminal execute:

mount /dev/sda5 /mnt/sdab

This mounts the partition into the filesystem in the
location /mnt/sda5, and makes it available for use. If
you use the Konqueror method, pay attention to the
location the device gets mounted, as you will need to
refer to it later.

4. Next, we need to remove the default location that
Synaptic uses to cache downloaded packages. We
cannot use this location in the Live CD environment
due to the large number of packages that must be
downloaded. To do this, execute in a root terminal the
command:

rm -rf /var/cache/apt/archives



5. Now create the storage folders on the storage device
for Synaptic to use. For this, use the command:

mkdir -p /path-to your storage device
/archives/partial

In this example, in a root terminal execute:
mkdir -p /mnt/sda5/archives/partial

6. Now create a link to the storage folders, in the place
that Synaptic expects to find it. For this use the
command:

In -s
/path to your storage device/archives
/var/cache/apt/archives

The example looks like this: As root:

ln -s /mnt/sda5/archives
/var/cache/apt/archives

7. Next, mount the media that contains your
"installed.txt" file. Then start Synaptic, and if
prompted to update your repositories, select cancel.
From Synaptic's settings menu, select repositories.
Make sure that ibiblio, or one of its mirrors is selected
(only one), and that the sections box reads "os texstar

updates (for .92) or "os texstar updates 93" (for any
.93 version.) Note: If the system you wish to update
has had any packages installed from the unstable
section, you should add it after "os texstar updates" or
"os texstar updates 93" in the sections box, so those
packages will be updated also.

Click "okay" to leave the dialog. From the Settings
menu, select Preferences, then on the Temporary Files
Tab, check the box that corresponds to "leave all
downloads in cache." Click "okay" to exit the dialog.

Click the Reload button to update the package listings.
Select "Read Markings" from the File menu, and point
the dialog to the installed.txt file you brought with
you. This will load the package list. Click Apply. In
the summary dialog, check the box that says
"download files only." Click Apply (in the dialog), and
the downloading of package files will commence.
Dependent upon connection speed, this could take
some time to complete. Once completed, any
additional packages that you would like to be included
in the Update CD can be marked and downloaded as
well. Just pay attention to the capacity of your media.

8. Once the downloads have completed, create the
directory structure of the update CD. Use the
command:



mkdir -p
/path to your storage device/pclinuxos
/2006 /RPMS.uucd

Example, as root:

mkdir -p
/mnt/sda5/pclinuxos/2006/RPMS.uucd

BIG NOTE: The RPMS folder name must be in
uppercase, and have an extension. Any extension will
do, but without it, the genbasedir command you will
run in step 9 will fail.

9. Next, copy the downloaded files from Synaptic's
cache, to the newly created directory structure. Use
this command:

cp -V

/path_to your storage device/archives/
* . rpm /path to_your storage device
/pclinuxos /2006 /RPMS.uucd

In the example, as root:

cp -v /mnt/sda5/archives/*.rpm
/mnt/sda5/pclinuxos/2006/RPMS.uucd

10. Navigate to the RPMS.uucd folder, using the
command:

cd
/path to your storage device/pclinuxos
/2006 /RPMS .uucd

In the example, as root:
cd /mnt/sda5/pclinuxos/2006/RPMS.uucd

Once there, build the package lists for Synaptic to use.
As root, from within the RPMS folder, we enter the
following command:

genbasedir --flat --bz2only --
progress /mnt/sda5/pclinuxos/2006

11. That is it. If you have a spare burner that is not
being used by the Live CD, you can fire-up K3B and
burn the /pclinuxos folder and all it contains to disc. If
not, you will need to reboot the machine with another
installed OS that has access to the storage partition,
and burn it there, or migrate the folder to another
machine that has this capability. If you used a
removable storage device, then you can unplug it and
take it with you.

Once the Update CD has been created, you can use
Synaptic to install its contents. Start Synaptic on the
machine you wish to upgrade, and disable the on-line
repositories. From the Edit Menu, select "Add CD-



ROM." When prompted, insert the Update CD in the
drive and click okay. A dialog will appear asking you
to give the disc a name. Call it anything you want.
Once it is loaded, click Mark all Upgrades and apply,
and within a matter of minutes your machine will be
fully updated. It is advised that you reboot after
updating, as many critical system packages will be
installed in this process, and they need the chance to
be reloaded. If you wish to have the entire repository
on hand, we can burn a "snapshot" to either a dual
layer, or 2 single layer DVDs. We'll cover that next.

How To Create An PCLOS DVD
Synaptic Repository (snapshot)

Purpose:

The purpose of this document is to describe the steps
necessary to create a complete PCLOS Repository on
DVD, for the purposes of upgrading and/or installing
additional software on PCLOS users' machines that
have limited, or no Internet connectivity.

Requirements:

1. A Linux machine with a fast Internet connection

and the ability to download and store upwards of SGB
of data.

2. The ability to burn either a Dual layer (preferred),
or Single Layer DVD.

The Steps:

1. Create a working directory. You will need to create
a folder to store the downloaded files, in a place that
you have write access to. For example purposes, we
will assume that your username is billybob, and you
want to create a folder called pclosmirror in your
home directory. In a terminal, execute the following
command:

mkdir /home/billybob/pclosmirror

2. Copy the apt repository from ibiblio to your
working directory. For this we will use rsync. Rsync
will create an exact mirror of the PCLOS apt
repository. The first time you run the command, it will
download approximately SGB of data! Depending
upon the speed of your Internet connection, this can
take quite some time. I generally let it run overnight.
The server load should be less at this time. Once you
have run this command the first time, on subsequent
attempts, it will only download those files that have



changed since the last time it was run. This makes
maintaining a current repository fairly quick, and
reduces bandwidth usage. The following code
excludes the experimental (exp) section as well as the
sources, from transfer. If you wish to include those,
remove the --exclude options from the command
string. Be aware of the effect that adding these
sections will have on your repository size! Execute the
following command in a terminal:

rsync -av --progress --delete --
exclude=RPMS.exp/ --exclude=SRPM*/
distro.ibiblio.org::texstar/pclinuxos/
apt/ /home/billybob/pclosmirror

3. Burning a Dual Layer DVD: If you have the
capability of burning a Dual Layer DVD (DL), then
fire up K3B and start a new DATA DVD session.
Right click at the bottom of the K3B window and
select 8.0 GB from the Media type menu. Then,
simply drag the /pclinuxos folder and all of its
contents to the creation window. This folder will be in
the root of the working directory you created in step 1.
Burn at a moderate speed (4-6x), and select "verify
written data." When finished, you will have a
complete PCLOS repository mirror, on disc, that can
be used with Synaptic.

Simply start Synaptic, disable your on-line

repositories from the Settings menu, then select "Add
CD-ROM" from the Edit menu. Put your disc in the
drive, click Okay, and give the disc a name when
prompted. It can be any name you wish. The disc will
load, and you will be able to upgrade, or install new
packages with no Internet connectivity required. Big
Note: This disc will include the .92 or .93 repositories,
and the unstable sections, unless they were explicitly
excluded with the rsync command string. If you do not
wish to use packages from these two sections, then
you MUST remove the listings in Synaptic. To do this,
select repositories from the settings menu, highlight
the line pertaining to your DVD repository, and
remove 93 and unstable from the sections box.

4. If you cannot burn a DL Disc: You will need to
use two single layer discs and split up the repository
files, as they are too big to fit on one SL Disc. I find
this easiest to do from within K3B itself. To create the
first disc, as in step 3 above, start a new DATA DVD
Project with K3B. Drag and drop the /pclinuxos folder
from your working directory into the creation window.
You will notice the indicator bar turning red,
indicating the data you have selected is too large to fit
on the single sided media. That 1s okay, as we are
going to remove some things. In the left hand pane of
the creation window, drill down in the directory tree
until the contents of the 2004 folder are visible.
Remove all of the /RPMS folders EXCEPT /RPMS.os.



Then, open the /base folder, and remove all files
EXCEPT those pertaining to the os section. You will
want to keep the following files only: release,
release.os, pkglist.0s.bz2, and srclist.0s.bz2. Then,
burn the project and label the disc DVDI for future
reference.

To create Disc 2, we repeat the previous process of
dragging the /pclinuxos folder to the DVD creation
window. Then remove the /RPMS.os folder from
/2004 and the files: release.os, pkglist.os.bz2, and
srclist.0s.bz2 from the /base folder. Burn the disc and
label it DVD2.

Start Synaptic, disable your on-line repositories and
select "Add CD-ROM" from the edit menu. Insert
DVDI1 and name it DVD1 when prompted. Synaptic
will ask if you wish to add another Disc. Select yes,
then insert DVD2. Name it DVD2 when prompted.
You are now ready to update or install new packages.
Synaptic will copy your selected packages from disc,
and prompt you when it needs files from the disc that
is not in the drive. Again see the previous Big Note.
The .93 and unstable sections will be on DVD2 in this
case.

That is all there is to do. Whether you only want to
keep your system updated, or have the complete
PCLOS repository on hand, you now have everything

you need. What a nice way to bring in the new year!

The Bleeding Obvious

Believed to be in the public domain

Customer: "l received the software update you sent, but | am
still getting the same error message."

Tech Support: "Did you install the update?"

Customer: "No. Oh, am | supposed to install it to get it to
work?"

Customer: "I'm having trouble installing Microsoft Word."
Tech Support: "Tell me what you've done."

Customer: "l typed 'A:SETUP"."

Tech Support: "Ma'am, remove the disk and tell me what it
says."

Customer: "It says '[PC manufacturer] Restore and Recovery
disk'."

Tech Support: "Insert the MS Word setup disk."
Customer: "What?"

Tech Support: "Did you buy MS word?"

Customer: "No..."

Customer: "I'm thinking about writing a book on the problems
I'm having with S3 Video cards and Warp and..." (blah, blah,
blah, etc.)

Tech Support: "What exactly is your problem?"

Customer: "I've downloaded the video drivers for the
PS/VP's with the S3 chipset, and they won't work on my
machine."

Tech Support: "Have you got a PS/VP sir?"

Customer: "Well...no."




I Was A Linux-er

Before Linux Existed

by David (aka RaveDave)

q ravel agents are indeed helpful people, they
can sell you a ticket for a trip to almost
anywhere, but they can't sell you one for
your journey into Linux.

That is a ticket which can only be self-issued. As with
any journey, you need a reason to make it, somewhere
to travel from, and a destination at which to arrive.
Some people like things quite well enough where they
are, and see no reason to move on. Others are the more
restless types, bored by limited sameness, frustrated by
restrictions, so that they are drawn to seek wider
experiences, more challenges, more choices, more
everything, even before they know that there is really a
more, at all. I was a Linux-er before Linux existed.

At least I was in the Era of Windows-2.0, 1987, which

promised so much, and yet did so very little. Somehow
I knew that I wanted more - more functions, more
choices, more everything. I was like poor Oliver Twist,
"Please, sir, may I have some more...?" But I received
the same answer as Oliver. In 1987, Linus Torvalds
had not yet made his own "little program" to use at
home, because he could not afford to buy a copy of
Minix. But my journey began there, out of DOS, into
Windows, and what I wanted, the More Everything,
whether it then existed or not, was a user-usable, PC-
friendly, Linux.

Some journeys go neither as planned, nor even as
wished for. Oh, there were interesting, even promising,
way points: Windows 3.0, released too early - and
where have you heard that before? Its successor,
Windows 3.1, was sort-of, nearly-almost, what Bill



Gates had promised in the late 1980s: "A new
Windows, with pretty pictures, moving pictures, a new
user experience, as good as a Mac - but under half the
price!" That, after the hiccup of Windows 3.0, and the
hurried release of 3.1, might have amused the Mac
fans, but it wasn't actually "As good as a Mac."

Windows was very far from that, and it still is.
Windows 95, with its Windows 98 and 98SE
upgrades, didn't do it, either. But I kept on with
Windows, eagerly awaiting every fanfared new
innovation, to see if that would at last have the More
Everything. Along the journey, due to a shoulder
injury that meant I could no longer do heavy lifting,
and so could not continue as a semi-trailer operator, I
needed a change of career. I had no business or trades
skills, so, what to do next? To turn a hobby into a job
seemed to be a possibility, so I retrained as, at first, a
Computer Assembler, then as a Tech Assistant.

Next, I worked in an assembly shop, then as a
workshop and front-counter assistant in suburban PC
dealerships. There I was introduced to the idea that PC
Owners are the Sheep. What happens to Sheep, needs
no reminder. After quite some time, [ was able to
obtain "proper" Technician Certification, CompTIA's
A+, only to have employers state, when I displayed it,
"Oh, that's American, it doesn't apply here!" when I
thought it would get me a little more pay. Actually, it

is recognised in the Australian IT Industry - just that it
selectively is not, by suburban dealership owners who
don't want to pay Trades level wages.

But it was, at least, an "Oh, you've done that one, have
you?" help in getting work. So I did get quite an
interesting insight into the PC side of the Industry, and
into the industry's all-too-common treatment of the
users, bringing their ailing Windows PCs in for
troubleshooting and repairs. Or the attitudes taken
with those wanting a PC built, to a price, or for a
purpose, or even, the "Latest and Best of Everything,
mate!" from the ones with deeper wallets. Sadly, and
often, we were not entirely truthful with best, or even
"Fully adequate for your needs, Ms/Sir." Because
those PCs, whatever the prices, were never the "best of
everything". They were Windows PCs, 95s, 98s,
98SEs, even the interim ME-gap-fillers.

Then, of course, came our Bill's one-platform dream, as
Ox finished, and NT escaped the confines of the
commercial networks, and onto the XP-PCs of an
unsuspecting world. More? Of everything? Not even
halfway-nearly. Change the desktop graphics, enlarge the
file sizes that are manageable, give it a lot more processor
and RAM, and an XP-PC is Win98SE on steroids. Not
very good steroids at that, from the user side, at least. For
me, Windows began in the 1980s, and ended in March,
2000, with Windows 98SE2, the last of real 9x. The last



PC-designed O/S from Microsoft.

NT was never Windows to me, and until the
advertising for the newly innovated NT-4, it wasn't to
Microsoft either. In fact, the Microsoft Press Tech
Manuals (plural for years), insisted that NT wasn't to
be deployed into the domestic environment. Oh, they
did the best they could, with what they had, sort of.
And long ago, Bill's promise did indeed put Windows-
3.x PCs into millions of homes. That established the

user-base of what 1s now well over 90% of the Western

World's PCs. A remarkable achievement, to have over
half a billion users quite convinced that their PC has
the "Everything," and does "Everything," that a Home
Computer could possibly do. When it does not, that is.

So over half-a-billion users can be wrong, without of
course, almost all having the first clue that they just
might be. Many are as yet unaware that my wild-mad-
dream of the 1980s has finally come true. "More
Functions - More Choices - More Everything," has
really arrived. Ushered in by an elegantly tuxed penguin,
even the "more-choices", has "more choices." There is
certainly no shortage of Linux distros that can be run on
a home computer. The user dilemma now, is which
"More Functions," and which "More Everything," do
they want with their "More Choices," of distros.

PCLinux0S 0.93a Junior

Texstar announced the release of PCLinuxOS 0.93a Junior on
August 9, 2006

PCLinuxOS 0.93a Junior was the next step up from MiniMe.
Junioir comes with just the basic desktop allowing full user
customization.

PCLinuxOS 0.93a Junior is a self booting Live CD with
advanced hardware detection. In addition to running Junior in
Live CD mode, you can also install it to your computer. Easy to
follow instructions are included on the Live CD as well as a chat
channel for instant help.

Junior comes with a set of pre-selected programs for Web
Browsing, Email, Instant Messaging, Blogging, IRC chat, Music,
Graphics, Video (additional software required for encrypted DVD
playback and proprietary formats), Digital Camera, Games, Ftp,
Bit torrent transfer, CD/DVD burning and more.

If you are first time Linux user or someone migrating from
Windows then PCLinuxOS 0.93a Junior is a great way to get
started using Linux. After installing PCLinuxOS to your computer,
you can access an additional 5000 programs and libraries from
our free software repository.

The current list of programs on Junior can be found at
http://www.pclinuxos.com//page.php?12l.


http://distro.ibiblio.org/pub/linux/distributions/texstar/pclinuxos/live-cd/english/preview/pclinuxos-p93a-junior.iso
http://www.pclinuxos.com//page.php?12l

Microsoft

by britbrian

Place: IT Planning room at: Newham Council,

Munich City, Bristol City, Madrid City, Seoul City, etc.

Chairman: Well committee, thanks for the members'
input and a big thank you to the OSS feasibility study

group.
OSS study group: Our pleasure chairman.

Chairman: So your conclusion is, to migrate all of
our departmental servers except the Windows
Exchange server to Linux; migrate non technical staff
desktops to ubumdo & OpenOffice and migrate
everyone's email from Outlook to Evolution.

OSS study group: Umbh that's Ubuntu.

Linux Users Owe

Chairman: Ubuntu OK, and this migration will be
staged over 16 months, correct?

OSS study group: Yes, first the IT staff will migrate
so they will be able to train the staff, then the least
technical staff moving on toward more specialized
staff.

Chairman: What are training costs?

OSS study group: Actually about the same as when
moving to MS's newest products every 3 years or so,
but Linux desktop & OpenOffice training is a one

time event.

Door flings open



Ballmer: Excuse me, let me catch my breath, hhh...
hhh, hhhhh, here just got off the plane, OK?

Chairman: You are?
Ballmer: Steve Ballmer, CEO of Microsoft.

Chairman: Welcome to our fair city Mr. Ballmer; we
weren't expecting you, please take a seat.

Ballmer: Well I've been flying a lot lately, haven't had
time to formalize visits. Anyway, surprise!!

Chairman: Do you have something to contribute?

Ballmer: Well yes, we at Microsoft have come to
accept the importance of interoperability between
Windows and Linux, so we have accepted a wonderful
opportunity from Novell to work together. We would
like to offer you vouchers for Novell Suse desktops for
a very fair...

Chairman: Excuse me, Mr Ballmer, but we have a
very good recommendation to use Abundo, what is
Soo0z?

Ballmer: Suse is a LEGAL Linux that respects our IP,

1.e., our INTELLECTUAL PROPERTY where as
Unbundo steals our IP and robs us of our hard work

and innovations.

Chairman: Thats very interesting, so Sooz can do
everything that Abundo can do?

Ballmer: Absolutely, it can legally exchange
documents with the STANDARD Office doc format; it
can legally play multimedia using Microsoft media
formats - legally.

Chairman: You said legally twice.

Ballmer: Oh yes, well WE own the INTELLECTUAL
PROPERTIES in those other Linux ones.

Chairman: Specifically?

Ballmer: Well there's too many to mention, but just to
get started, we invented the 3 button mouse, so all
desktop menus using the middle & right button violate

our [P and all Linux's do copy our mouse innovations.

OSS study group: Hmm, Mr Ballmer is confusing the
Linux kernel with the Desktop Environment?

Chairman: Wait a minute, I'm talking to Mr Ballmer.
So Linux has mouse IP violations?

Ballmer: Yes and thats just the beginning. You see we



invented everything to do with Windows, and Linux
simply copied it all. The developers and distributors
haven't paid us for our IP. So we have generously
agreed to help Novell out of this legal difficulty by
promoting their Suse distribution that THEY FULLY
OWN. We propose for five years not to sue Suse users,
but we are open to other distributors joining our
generous offer. Otherwise we will be obliged to our
shareholders to seek financial remedy from all the
commercial distributions STEALING OUR IP.

OSS study group: Uhmm Mr Chairman, Microsoft is
trying to...

Chairman: So Mr Ballmer, Suse is what you
recommend?

Ballmer: Yes, then you will have full interoperability
with Windows that just works.

Chairman: OK, we will accept your recommendation
and use Suse.

Ballmer: Then in five years, the agreement will end
and you will be able to upgrade to Vista and Office 12
that just works.

Chairman: Would we save money by staying with
Windows?

Ballmer: Of course, let's talk details privately.

Chairman: Meeting is adjourned, the city of ... thanks
the OSS study group and all those who have
contributed to this productive meeting. We will
upgrade to Windows Vista.

Plea for Help

The PCLinuxOS Hardware Database project
needs your help. For those who may not know,
this database is being developed to make it
easier for PCLOS users to determine in advance
how well a piece of hardware works with
PCLOS. It takes a lot of work to sort through all
the possible hardware and develop such a
wealth of information into usable form.

Jmiahman posted recently that he was not
receiving much information from the community.
Please take a moment and visit the site and
provide what information you can regarding your
hardware. We all will benefit in the long run.
Thank you.




Guide to Installing
Diablo II LOD with
PCLinux0OS and Wine

by Misfit138
ven if you don't run LOD (Lord of Destruction),
you may find this guide has some useful pointers The game runs velvety smooth on my newer machine,
for Wine in general, and older games. even better than in Windows.

This quick guide is assuming that you have Wine Hardware:

installed through Synaptic (or apt-get), that it is
version 0.9.23, you are running PCLinuxOS 0.93, are EPoX EPONPA+ Ultra

using Alsa, and have your proprietary 3D video x2 3800

drivers installed. If you have no 3D drivers, the nv" 2gigs RAM

drivers should work with Nvidia cards, and the game eVGA 7600gt

should work in 2D mode, if you follow these Crummy old dumpster-diving Compaq S700 CRT
instructions. I have also installed on the Intel 810 monitor

onboard video chipset, with 100% success, in 2D
mode only. Also works quite well in 2D mode on:



Compagq Presario

Celeron 733

256MB RAM

Intel 810 onboard video

Crummy old dumpster-diving Compaq S50 CRT
monitor

Step 1. Launch Wine's configuration tool.

Step 2. Click on the graphics tab. Enable desktop
double buffering, allow the window manager to
control the windows, and emulate a virtual desktop at
800x600 resolution. Uncheck pixel shader support and
scroll down to vertex shader support. Choose
"NONE," then click apply. (Note, if you cannot see the
"apply" button, you are probably at 800x600
resolution on your 'true' desktop. Just hold down the
alt-key and click on the configuration window to move
it up a bit, so you can click it)

Step 3. Click on the applications tab. Scroll to
Windows version, choose "Windows XP," and click

apply.

Step 4. Click on the Audio tab and choose ALSA,
uncheck OSS.

Step 5. This is perhaps the most important step.
Change your PCLinuxOS Desktop resolution to

800x600. This can be done by right-clicking on the
desktop and choosing 'configure desktop'. Scroll down
to "display". If 800x600 is not available, then you
must edit your /etc/X11/xorg.conf file to allow
800x600 resolution. (WARNING: If you fail to
change your desktop resolution to 800x600, Wine will
crash during a patch update, as it will fail to be able to
communicate with your video card and you will get an
error message stating that the patch archive is corrupt.
The install will be unusable at this point.)

Step 6. Have some coffee, take a break. Read some
Mark Twain, read the Gentoo install manual. We will
be installing the game in 2D mode, using virtual
desktop. "Why," you ask? The answer is a bit elusive,
however, my best guess is that the original version of
the game only supports 640x480, and Wine has a hard
time communicating with the video card when your
true desktop resolution is above 800x600. Only after
you have upgraded to the Lord of Destruction
Expansion Pack, will you be able to get the game to
have 800x600 support, then the virtual desktop will be
at 800x600, your true desktop can then be set to
1024x768. You may then disable the virtual desktop
option and play the game in full screen mode! Next,
we can enable vertex and pixel shader support, and
3D. You may experiment at your leisure with various
desktop and virtual desktop resolutions, (AFTER
THE INITIAL INSTALL!) but the following steps



are known to work with my hardware. Note, if the
desktop resolution is at 1024x768, Wine will crash
during the patch install and you are stuck! I cannot
stress this enough!

Step 7. Install the 'full' base version of the game
(1550MB) through the Wine file manager, from
virtual drive D. Register, or read the readme if you
wish. (It does a body good, and somewhere a baby
dolphin dies if you don't.) Run the video test. Ignore
the recommendation and choose the 2D driver.

Step 8. Launch the game in single player mode to
make sure you are getting video. Run around a little to
make sure you do not freeze.

Step 9. Launch Battlenet. The game will detect there
is a newer version and will patch you up to the latest
version. If you followed my instructions, then you
should see a progress bar during the patch installation
process because Wine was able to shut off your 2D
video. You can stop here and enjoy your new 2D
install through Linux! What is better than this? (Well,
3D I guess.)

Step 10. If you purchased the LOD expansion, install
it now, and launch battlenet once more. Again you will
be patched up to the latest version.

Step 11. Go into single player mode and hit the "esc"

key for options/video. Choose 800x600, apply, and
exit. (Note that 3D perspective is unavailable.)

Step 12. Run a video test through
wine/start/programs/diablo II/video test. Skip the test
and choose 3d driver.

Step 12 2. Run the Wine configuration tool and
choose vertex and pixel shader support under the
video tab.

Step 13. If you are feeling lucky, restart the game and
you will notice that under video options, 3D
perspective is now available!

Now that you are done, you may use up to 1024x768
resolution for your PCLinuxOS Desktop, and the
install will still work. I have not tested above that
resolution. You may also want to disable the virtual
desktop option in the Wine configuration tool at this
point. This yields the most realistic playing
experience, as the game will truly be full screen. You
can also launch the game from a terminal, through
KDM, and play in full screen mode! Just enter the
command: wine 'c:\Program Files\Diablo II\Diablo
Il.exe' (exactly as typed, at the command line.) This
option also works better for older machines with
256MB RAM, the game will run quite smoothly.



by mwananchi

n PCLinuxOS, it is strongly advised to install
f ’ programs only from the official repositories

through Synaptic, and users are advised to
look there first for programs they want. If a program
isn't there, it can be requested on the main PCLinuxOS
forum in the request section. Sometimes, installing
programs from source may be a more desirable option
than the previous two, and this is a tutorial on how to
do that. Installing a program from source is a 3 stage
process.

Running a configuration script

In this stage, a program checks to see if the system
meets all of the program's requirements and some
other, system-specific variables. A custom install can
be built by passing various options to the script at this

How To Install Programs
From Source Code

stage. If a system fails to meet the requirement, the
script will stop with an error message specifying what
requirement wasn't met. Synaptic should be the first
place to go look for the missing program, library, etc.
Often, what is needed is the development package of
the program; development package names usually end
with "dev."

If a ——prefix option is not passed to the script,
most scripts will use /usr/local, but others will
use /usr. For the sake of consistency, it is generally
advised to pass this option. It is a convention in Linux
to install personal programs in /usr/local, and to
have the ones being managed by the distro, in /usr.
This ensures personal programs/versions can coexist
with the ones being managed by the distro (through
Synaptic).



Some programs will have a list of programs that must
be installed for the configure stage to pass
successfully. It might be a good idea to check the
requirements before running the configure script. This
will allow you to avoid the annoyances of having to
meet each requirement, one at a time (often referred to
as dependency hell). Some programs will have a
readme file with the source code; it is a good idea to
read this file first, before doing anything, as it may
contain specific instructions. The help option
(./configure --help) might provide other
useful options, if a custom installation is desirable.

Make

In this step, the source code of the program (usually in
text format) is translated to machine code (binary
format ). This stage is usually the longest (it could take
a couple of minutes, or many hours for large
applications). The make program will bail out at the
first sign of trouble and, if you don't want to go
through the source code to correct the trouble
yourself, I would suggest you just delete the program
and forget about it. Then you could exercise your
option to request the package in the request section of
the forum.

Make install

The last stage is the installation of the program
(assuming the previous stages passed successfully). At
this stage, the binaries made in the previous stage are
placed in the appropriate places in your system and
necessary changes are made to make them run.
Desktop icons, entries to the menu, and file
association entries are not made; these must be done
manually.

These 3 stages can be done step by step or all at once.
From inside the folder containing source code of the
program to be installed, press "F4" to launch a
terminal, then type: . /configure --
prefix=/usr/local (note the dot at the
beginning). When that's done, type: make to build the
program. Finally, type: su -c make install to
install the program. This last stage will prompt you for
a root password (assuming you are not root already).

Those 3 stages can be combined into a single line with
this command: su -c "./configure --
prefix=/usr/local ; make ; make
install™" if you are not root, or just with:
./configure --prefix=/usr/local ;
make ; make install if you are.



Uninstalling the program

The program can be uninstalled with: make
uninstall from inside the program's source code.
This command must be issued with root privileges.

Useful commands to know

which program name

This command will return the full path of
program_name that will be executed when any
program just calls "program_name."

whereis program name

This command will return full paths of all
"program_name" installed on a system.

These two are useful if more than one version of the
program is installed in a system.

Interesting notes

If the -—prefix=/usr/local option is passed to
the configure script, binary files (or executables), aka
.exe in Windows, will be placed in

/usr/local/bin. Shared libraries (.so), aka .DLL

in Windows, will be installed in /usr/local/1lib.
Documentation files, icons, images, and other
necessary files usually go in /usr/local/share.

Global program variables will usually go in the /etc
folder.

The Bleeding Obvious

Believed to be in the public domain

There was a really angry user who called, saying the
company was @#$'# and its products were |@#$@, and
Tech Support was @#$*! too. He said he bought their
graphics card, and it didn't work, and what the @&$!# was
someone going to do about it before he sued their lying butt.

He didn't actually have the product.

"I've bought a stolen CDD3610 which didn't come with any
software or cables. Could you please send that to me? |
presume | do have the full 12 months warranty?"

Customer: "l would like to place an order."

Tech Support: "Unfortunately, we are unable to take orders
over the phone. All orders must be placed on our web site."
Customer: "Web site?"

Tech Support: "You need access to a computer that's
connected to the Internet in order to visit our Internet site and
place an order."

Customer: "Where is the computer?"

Tech Support: "..."




Screenshot Your
Screensaver

by Tim Robinson

saw a post in the PCLinuxOS forum, asking
if there is a simple way to grab a screenshot

while a screensaver is running. Here's how to

New Snapshot

i

do that:

Right click a blank area on your desktop and select
"Configure Desktop." Set your screensaver to come on
in 1 minute or less.

Save As...

Copy to Clipboard

Open KSnapshot and configure it to snapshot the Erint...
entire screen, and set its delay to something longer SRR o T
than the screensaver delay (see screenshot on left). Be Capture mode: (Full Screen 4=
sure to select "Full Screen." Click the New Snapshot Snapshot delay: |5 sec L:
button. B
1|
Wait. The screensaver will come up, and after the [ —n
delay, KSnapshot will grab a copy of what's on screen. &y




If you prefer, set the KSnapshot delay to whatever you
like, and then, after pressing the "New Snapshot"
button on the configure screensaver dialog, click the
"test" button to start the screensaver. A few seconds
later the screenshot will be made and you can press
Esc to stop the screensaver test.

Once back in KSnapshot, save the snapshot
somewhere (it will be saved as a .png file) or tell
KSnapshot to place it on the clipboard so you can
insert it into a document of your choice.

Advertisement:
Are you a happy PCLinuxOS user? Would

you help make PCLinuxOS better?
Consider a

DONATION

http://www.pclinuxos.com/page.php?1l

The Bleeding Obvious

Believed to be in the public domain

A haughty caller to the Claris Works cue began haranguing
them about the Claris Works she'd just bought. When her
tirade abated enough for them to ask a few probing
questions, she explained that the box promised a word
processor, but there wasn't one inside. | asked her to insert
the disk from the box into her computer.

Customer: "Computer? | don't have a computer!"
Tech Support: "Ma'am, Claris Works requires a computer.”

From here, she became irate. She dragged in two levels of
supervisors, several lawyers, later. No one ever laughed and
always maintained a professional demeanor. The customer is
always right.

A woman walked into the room and came up to the desk
marked "COMPUTER HELP DESK" with computers on it, one
of which was being used by a customer service person.
"Excuse me," she asked. "Do you know anything about
computers?"



http://www.pclinuxos.com/page.php?1

Desktop Changes

by Rodney Adkins

t one time we were all "newbies." Making

the transition from Windows to

PCLinuxOS is not a great leap. Most
people would find the desktop on PCLinuxOS as
simple to use as any in MS Windows. Unlike
Windows, where you cannot change or customise
things very much, there are a lot of options in
PCLinuxOS that can be changed to make your desktop
feel completely yours.

One of the things I like to do when I look at a new
distro, is get under the 'hood' and see how much I can
change things to my liking. One of the advantages for
me, is that PCLinuxOS allows me to change almost
anything I wish.

Personally, I do not like any icons on the desktop, so
the first thing I did when I had PCLinuxOS up and
running, was to drag and drop the trash can into the
task bar at the bottom of the screen. This gave me
access to the trash can and allowed me to get it off the

desktop. Next I opened KDE Control Center, clicked
on "LookNFeel," clicked "Behaviour," and cleared the
box with "Show icons on desktop." This cleared all my
icons off the desktop and gave me the feel that I like.
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Playing in the KDE Control Center, I soon found that I
could change the look and feel of the menu, and how it
worked. One of the most annoying parts of Windows
for me, was the fact you had to go to "Start" to shut
down the computer. I was pleasantly surprised in
Linux, especially with PCLinuxOS, when I found that
I did not need the launch button at all. Still in
"Behaviour," under "Mouse Button Actions," you will
find an area for the left, middle, and right mouse
buttons. Under the left mouse button, change it so the
choice is "Application Menu." What that allows you to
do is go to the task bar, remove the Launch Icon, and
you can now launch your menu by clicking any area of
the desktop. I have gotten so used to this method of
launching the menu, that when I work on a computer
that does not run PCLinuxOS, I have to stop and think
how to launch the menu!

In KDE Control Center you can also change the colors
of the menu, and the look of your program. Just go to
"Colors" and change things, to get the 'look’ you want.
Also, you can change the font size and font type under
Fonts. Personally, I downsized the fonts to 12, and on

my menu [ prefer a size 10 Verdana font for a cleaner
look.

One thing I really like about PCLinuxOS is when I
click on "Panels" in the KDE Control Center, it allows
me to do some things that Windows never did. I can

now change the Taskbar to how I want it to look and
react.
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As you can see in the picture above, I have shortened
the length of the Taskbar to 1%, and changed the
height to 'Tiny'. To center the Taskbar, I clicked on the
middle bottom button. By clicking on the "Hiding
Tab," you will find that you have choices of how to
hide the task bar too. I chose to have mine hide
immediately. Then I clicked on "Raise When The
Pointer Touches," and chose the bottom edge of the
screen.

I also changed the size of the menu by clicking on the



"Menus" tab. Under "Menu Item Format," I clicked
'Name Only' and chose to leave "Side Image" showing.
I like to have as small and compact a menu as
possible, so the only thing I left clicked in the
"Optional Menu" was 'Find'. Under the "Quick
Browser" menu I unchecked the box and changed the
number to 1. Under the "Quick Start" menu I chose 0.

If you click the "Advanced" tab you will find a section
on "Panel Background." Click "Enable Transparency,"
click on "Advanced," and a pop up window will
appear that shows a slide bar. Slide it to "Min. Tint
Amount". The Taskbar is now transparent. Personally I
like the transparent look. To make the menu somewhat
transparent to match the Taskbar, click on "Style".
Under "Widget Style" choose "Plastic." Click the
"Effects" tab.

Under "Menu effect" change it to "Make Translucent".
Enable "Menu Drop Shadow". Select "Software Tint"
under 'Menu translucency type' and change the 'Menu
opacity' to your preference. For me, around 82% was
enough. Under "System Notification" you can turn off
or on the system notifications that you like, or want to
hear. Under "Taskbar" make sure it is set for
"Transparency."

By playing with the other options in the KDE Control
Center , like "Theme Manager," "Window Behaviour"
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and others, you can make PCLinuxOS look and feel
your own. Don't be afraid to get in there and try
things, nothing will break. The one thing I personally
would not activate in the KDE Control Center right
now is "Translucency", which can be found under
"Window Behaviour". My advice is to leave that
feature off. I have found it is not yet perfected and
seems to make my system a bit unstable. Now that the
KDE Control Center functions have been explained a
little, you can have fun exploring and changing the
desktop to suit your needs.



Audio CDs

by lakicsv

9 had been using various programs to rip
CDs to MP3 or Ogg, until I saw the
following tip (this blew me away with its

simplicity):

A) Insert your audio CD

B) Open Konqueror

C) Type audiocd:/ in the address line of Konqueror

and hit enter

D) You will be presented with a number of (virtual)

folders called Ogg Vorbis, MP3, FLAC etc. plus some

.wav files outside the folders.

E) If you want MP3s, just click on the MP3 folder

and drag the appropriate files (MP3s from your CD

tracks) to your desktop or a folder you created
somewhere in your home directory. Encoding is done
on the fly as Konqueror copies your files.

You can customize the ripping parameters in the KDE

control center. The filenames will appear with CDDB

information automatically (if the CD is found).

The Simplest Way To Rip
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Diskette

by Clareoldie

Intro

There has been a lot of interest lately in older
computer hardware. All the older computers I have
contain a floppy disk drive. Besides having files
archived to floppy, I also use some DOS utilities at
times. The purpose of this article is to describe how to
create a DOS floppy boot diskette, from within
PCLinuxOS, to which you can add small utilities
designed to work from DOS. Such tools as System
Analyser (http://www.sysanalyser.com/) or a BIOS
upgrade can be used in this fashion. Most users will
have an old MS boot diskette around somewhere, but
these are usually full and other utilities cannot be
added without deleting something. In this exercise we
will create a DOS boot diskette using "free" software.

Creating A DOS Boot

Method

The first thing to do is acquire a floppy image file.
You can download a suitable one from
www.fdos.org/bootdisks/. For this exercise, the zipped
file FDOEM.144.imz is suitable. Create a directory
called "bootdisk" on your desktop. Download
FDOEM.144.imz into the "bootdisk" directory. Using
Ark, extract the file FDOEM.144 from
FDOEM.144.imz to
/home/<your user name>/desktop/bootdisk.
Next, place a floppy diskette in the floppy drive and
without mounting it, right click on the floppy icon (on
your desktop) and format it as Primary, 3.5 inch 1.44
MB, DOS, using Full Format. Give it a label if you
wish. It is a good idea to verify the integrity of the
diskette also.


http://www.sysanalyser.com/
http://www.fdos.org/bootdisks/

Please be aware that all previous content of the floppy
will be irretrievably lost when you do this.

So now we have a prepared floppy diskette and a boot
image for it. The next job is to "burn" the image to the
floppy. As with bootable CDs, it is not sufficient to
copy the file to the media. To "burn" the image, open
File Manager-Super User Mode and navigate to the
directory containing the floppy boot image file
FDOEM.144. Select Tools -> Open Terminal and a
terminal will open with root privileges. Be careful
what you type in here as any instruction you input will
be carried out, even if it means destroying the
operating system. With the unmounted floppy in the
drive, type in the following and finish by pressing the
'enter’ key

dd if=FDOEM.144 of=/dev/£d0

Be aware that Linux is case sensitive, so be sure to
type the file name exactly as it is saved on your
system. If your floppy drive is mounted at somewhere
other than /dev/fd0, then use what is suitable for your
system, in its place.

This command should cause the floppy to be written
to. It will take a few minutes to complete, so give it
time and wait for the prompt to re-appear. You should
now have a bootable floppy and I suggest you re-boot

your computer, with the BIOS set to boot the floppy
first, to check that all is OK. If it is, you should be
greeted with the A> prompt after booting. All that
remains is to re-boot with the floppy extracted, and
when in PCLinuxOS you can add whatever
program/utility you wish to the floppy, for use the next
time you boot it.

PCLinUx0OS MiniMe 0.93a

Texstar announced on August 9, 2006 the availability of
PCLinuxOS 0.93a MiniMe for download.

PCLinuxOS MiniMe 0.93a is the minimal version of our Live CD
for those who just want a basic desktop without the bloat
allowing for full user customization. Simply put the CD into your
CD or DVD drive and run it in live mode without ever touching
anything on your computer. In addition to the Live CD mode you
can also save your changes to a usb key disk.

PCLinuxOS MiniMe can be installed to your computer by simply
clicking on the install icon on the desktop and using the easy to
follow instructions provided you like PCLinuxOS and it runs well
on your computer.

After hard drive installation, you can access over 5000 programs
to fully customize your desktop the way YOU want.

PCLinuxOS MiniMe comes with the latest 2.6.16.27 kernel, a
basic KDE 3.5.3 desktop, CD Installer, Synaptic Software
Manager and Control Center.


http://distro.ibiblio.org/pub/linux/distributions/texstar/pclinuxos/live-cd/english/preview/pclinuxos-p93a-minime.iso

mklivecd Bug Fix

by Clareoldie

n the last release of PCLinuxOS (.93a) a bug
: ,became apparent after some users failed to

create remasters of their install, with the
output showing a series of . This only
affected users with separate /home partitions and
consequently was not discovered for some time. The
fix 1s relatively simple, requiring an edit of the
mk1livecd file. Details on how to implement this are
given below.

As user go to Kmenu -> Applications -> File Tools
and launch File Manager Super User Mode.
Navigate to /usr/sbin/ directory and right click
on the mk1livecd file. Select Copy and then right
click in the pane (but not on a file) and select Paste
File. Select Choose New Name and save the file;
mklivecd.bkp might be a good choice. The
original file is saved with the new name in case of
mishap and will allow you to restore it if necessary.
Go back to the original mk1livecd file and right
click; choose Open With and select KWrite or your

preferred editor. In the View menu of Kwrite enable
Show Line Numbers. This will place line numbers in
front of each line of the file. The edit requires you to
remove —mount from three locations. In turn scroll to
lines 734, 739 and 750 and remove the —-mount part
of the line. Be sure to delete the — as well as mount.
Save the file. You should be good to remaster your
installation now. The lines are listed below with the
parts to be removed in red (be sure also to remove the
space following —-mount).

(734) do cmd("(find $o root -mount -
type d

(739) do cmd("(find $o root -mount -
type £ 2>/dev/null | sed -e

's,"$o root,/,g' | grep 'Sex' | sed

(750) my @files = gx(find $o root -mount

-type £ 2>/dev/null);



Partition Tables
Explained

by hankurt
any people have difficulty understanding 0001b0O 00 00 00O 00 0O OO 00 0O 48
how the partition table on their hard drive 04 07 c9 00 00 80 01
works. The master boot record (MBR) 0001cO0 01 00 06 O0f ff e0 3f 00 00
contains the partition table, which contains the 00 bl 45 0f 00 00 00
location of up to four primary partitions on the disk. 000140 00 00 00 00 00 00 00 00 0O
One primary partition may be designated as a logical 00 00 00 00 00 00 OO
partition, allowing an operating system to treat that 0001e0 00 00 00 00 00 00 00 00 OO
primary partition as any number of logical partitions. 00 00 00 00 00 00 00
We will not discuss logical partitioning in this article. 0001£0 00 00 00 00O 00 00 00 00 00
The information for each partition is 16 bytes long 00 00 00 00 00 55 aa
(each byte is usually shown as a pair of hex digits, e.g.
0f). There is only one partition on this drive, and the

information that describes it is at address 0x0lbe to
Here's a typical partition table entry. 0x01lcd ( the red numbers in the table above ). If there




were more, the second partition's data would be those
shown in green, the third partition in purple, and the
fourth partition in brown. I'll copy those numbers for
the single partition below, and color code them for
easier reference.

80 01 01 00 06 Of ff e0 3f 00 00 00 bl 45 0f 00

The first hex number (red) gives two pieces of
information. If it is 00, then the partition is not the
active partition ( does not contain the boot loader ). If
it is 80 or greater, as in the example, this means it is
the active ( bootable ) partition. Only one partition
can be marked as active. The second piece of
information applies to fixed disks. If the first fixed
disk contains the active partition, this number will be
80. If it were the second fixed disk, this number would
be 81, and so on.

There are two ways that the location of the partition is
specified in the partition table entry. The first is the
Cylinder Heads Sectors method (CHS). The three light
blue numbers (01 01 00) specify the CHS location
where the partition begins, and the three dark blue
numbers (Of ff e0) specify where it ends. Sectors are
the smallest unit of space and cylinders are the largest
unit of space. Or to put it another way, there are so
many sectors per head, and so many heads per
cylinder ( this is important when you try to do math

with these values ).

Now to extract the actual values from the hex numbers
above. Sorry, but this gets tricky, and I don't know if I
can explain it well. The Heads value is easy, it is the
value of the first byte and can be from 0 to 255
(decimal). To get the other two values, we have to
convert the hex numbers to binary. The Sectors
number is the lower six bits of the second byte and can
have a value from 1 to 63. To get the Cylinders value,
we take the remaining two bits from the second byte
and add them to the high end of the bits from the third
byte. These 10 bits allow for a cylinder value from O to
1023. T will demonstrate with the CHS values from the
example.

Partition Starting Location

1st Byte 2nd Byte 3rd Byte
01 01 00
01 Head 1
00000001 00000000 Bytes
converted to bits
XX000001 Sector 1
00——=——- > 00000000

0000000000 Cylinder O



Partition Ending Location

l1st Byte 2nd Byte 3rd Byte
Of ff el
0f Head 15
11111111 11100000 Bytes
converted to bits
XX111111 Sector 63
11-———- > 11100000

1111100000 Cylinder
992

Since a partition always ends on a cylinder boundary,
we can tell that the drive geometry is 63 sectors per
head and 16 heads per Cylinder (counting head 0). So
the partition begins on the first sector of the second
head ( remember head 0 ) on the first cylinder. Since
there are 63 sectors per head, the partition begins on
the 64th sector. To see which sector the partition ends
on, we would multiply 993 cylinders ( remember there
is a cylinder O ) times 16 heads times 63 sectors. This
gives us 100944,

The Cylinder Head Sector method only works on
drives up to 8 gigabytes because that is the maximum
size that can be specified with the three bytes. To get
around this, a second method of specifying the
location of the partition is used. It is called Logical
Block Addressing, and it uses the last eight bytes in

the partition table entry. These bytes give the location
of the partition by counting the number of sectors
from the start of the disk, which is much simpler. The
four bytes in green (3f 00 00 00) give the number of
sectors before the partition, and the following four
bytes (b1 45 0f 00) give the length of the partition.

80 01 01 00 06 Of £ff e0 3f 00 00 00 bl 45 0f 00

We have to know just one thing to interpret these
bytes. They are in "little endian" order. This means
that the lowest "place value" is held by the first byte.
So to use them like we use ordinary numbers, we just
have to reverse the order of the bytes. So 3f 00 00 00
becomes 0000003t and b1 45 Of 00 becomes
000f45b1. Now we can convert these numbers to
decimal. This tells us that there are 63 sectors before
the partition begins at the 64th sector, and it is
1000881 sectors long. Thus the partition ends at sector
1000944. Notice that this is the same result we got
with the CHS math.

Last Piece of the Puzzle

In the partition table entry, the hex number 06 (in
purple) tells which type of file system the partition
contains, and whether the Cylinder, Head, Sector
(CHS) or the Large Block Addressing (LBA) system is



to be used to locate the partition. Here is a brief
listing of file systems.

01  DOS file system with 12 bit file allocation table
06 DOS file system with 16 bit file allocation table
and CHS system is used to indicate the partition
location

Oe  DOS file system with 16 bit file allocation table
and LBA system is used to indicate the partition
location

Ob DOS file system with 32 bit file allocation table
and LBA 1is almost always used, however if the
partition is in the first 8GB of the disk, the CHS
numbers should be set correctly, otherwise, if the
partition is past the 8gb boundary, the CHS numbers
should be set to their maximum value.

07 NTFS

81 Linux

83  Linux ext2fs

82 Linux swap

There are other file system types, but these are the
ones you will most likely run into.

The web pages where I got my information might
explain it better.
http://home.att.net/%7Erayknights/pc_boot/w95b_mbr.htm
http://www.bitzenbytes.com/Content-Arcanum-18-1-14.html
and some wikipedia articles.

MYPCLINUXOS

Got any GREAT ideas for a PCLinuxOS
project?

People are naturally creative and
imaginative. We come up with
outrageous, practical, silly, feasible, and
maybe unique ideas. There's a place for
you at MyPCLinuxOS.com.

Many great projects started with a small
step, and with a bit of dedication and
work, we can make a dream come true.

Lost for one? Or your idea was taken?
No problem. There are several ongoing
projects at MyPCLinuxOS.com. Join one
of them, and be a part of a team that
"gives something back" to PCLinuxOS.



http://home.att.net/%7Erayknights/pc_boot/w95b_mbr.htm
http://www.bitzenbytes.com/Content-Arcanum-18-1-14.html
http://www.mypclinuxos.com
http://www.mypclinuxos.com
http://www.mypclinuxos.com

DISCLAIMER

1. All the contents of PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), are intended for general information and/or use
only. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision.
Any specific advice or replies to queries in any part of the magazine is/are the personal opinion(s) of such
experts/consultants/persons and are not subscribed to by PCLinuxOS Magazine.

2. The information in PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), is provided on an "AS IS" basis, and all
warranties expressed or implied, of any kind, regarding any matter pertaining to any information, advice or replies, are
disclaimed and excluded.

3. PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com), and its associates shall not be liable, at any time for damages
(including, without limitation, damages for loss of any kind) arising in contract, tort, or otherwise from the use of, or inability to
use, the magazine or any of its contents, or from any action taken (or refrained from being taken) as a result of using the
magazine or any such contents or for failure of performance, error, omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use
of, information contained in the magazine.

4. No representation, warranties, or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular situation.

5. Certain links on the magazine lead to resources located on other servers maintained by third parties over whom PCLinuxOS
Magazine (http://mag.MyPCLinuxOS.com) has no control or connection, business or otherwise. These sites are external to
PCLinuxOS Magazine (http://mag.MyPCLinuxOS.com) and by visiting these, you are doing so of your own accord and assume
all responsibility for such action.

Material Submitted by Users

A maijority of sections in the magazine contain materials submitted by users. PCLinuxOS Magazine
(http://mag.MyPCLinuxOS.com) accepts no responsibility for the content, accuracy, and conformity to applicable laws of such
material.

Entire Agreement

These items constitute the entire agreement between the parties with respect to the subject matter hereof, and supersedes
and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.
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